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G protein-coupled receptors (GPCRs) constitute the largest family of plasma
membrane receptors and the main drug targets in therapeutics. GPCRs can es-
tablish direct receptor-receptor interactions (oligomerization), which can also
be considered as targets for drug development (GPCR oligomer-based drugs).
However, prior to designing any novel GPCR oligomer-based drug develop-
ment program, demonstrating the existence of a named GPCR oligomer in na-
tive tissues is needed as part of its target engagement definition. Here, we dis-
cuss the proximity ligation in situ assay (P-LISA), an experimental approach
that reveals GPCR oligomerization in native tissues. We provide a detailed
step-by-step protocol to perform P-LISA experiments and visualize GPCR
oligomers in brain slices. We also provide instructions for slide observation,
data acquisition, and quantification. Finally, we discuss the critical aspects de-
termining the success of the technique, namely the fixation process and the
validation of the primary antibodies used. Overall, this protocol may be used to
straightforwardly visualize GPCR oligomers in the brain. © 2023 The Authors.
Current Protocols published by Wiley Periodicals LLC.

Basic Protocol: Visualization of GPCR oligomers by proximity ligation in situ
assay (P-LISA)
Support Protocol: Slide observation, image acquisition, and quantification
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INTRODUCTION

G protein-coupled receptors (GPCRs) constitute the largest family of plasma membrane
receptors in eukaryotes (∼800 GPCRs in humans). GPCRs are grouped into six differ-
ent classes, from which only class A, B, C, and F are found in humans. The expression
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pattern of each class of GPCRs can vary widely across different tissues, depending on
their specific physiological functions. Generally, class A, the most abundant with 719
members (Congreve et al., 2020), is the most widely expressed of the four classes, while
class B and C GPCRs tend to be more tissue specific. GPCRs have a distinctive structure
composed of 7 transmembrane helices joined by three intracellular and three extracellu-
lar loops, plus an intracellular C-terminus and an extracellular N-terminus. GPCRs bind
to extracellular ligands (e.g., neurotransmitters, hormones) and transduce the signal into
the cell. The nature of GPCR transduction depends on the specific effector protein that
the receptor couples with (e.g., protein G, β-arrestin) (Hilger et al., 2018), thus present-
ing an extensive variety of signaling processes. The diverse signaling pathways activated
by GPCRs allow them to regulate a wide range of cellular functions, including sensory
perception, hormone secretion, neurotransmitter release, and immune response. Dysreg-
ulation of GPCR signaling has been associated with many diseases, including cancer, car-
diovascular disease, metabolic disorders, and neurological disorders. Therefore, GPCRs
are important drug targets in pharmacotherapy; more than a third of FDA-approved drugs
act on GPCR (Hauser et al., 2017).

GPCRs can establish direct protein-protein interactions, not only with their effector pro-
teins but also with other GPCRs, allowing fine-tuning of GPCR functioning (Ciruela
et al., 2010; Møller et al., 2018; Rukavina Mikusic et al., 2020). Upon GPCR oligomer-
ization, ligand-receptor interactions can be altered, resulting in novel pharmacological
properties (Ferré et al., 2022). In fact, changes in ligand binding (i.e., orthosteric and al-
losteric properties) and/or efficacy (i.e., intrinsic activity diversity) have been associated
with GPCR oligomerization (Fernández-Dueñas et al., 2012; Ferré et al., 2022; Sarasola
et al., 2022). Consequently, the study of GPCR oligomerization may offer new opportu-
nities toward the discovery of new pharmacological tools.

The existence of protein-protein interactions (PPIs) can be assessed by several method-
ologies. Some are based on a protein complementation assay (PCA) that relies on the
reconstitution of a functional protein (e.g., YFP, RLuc, transcription factor) from two
physically separated inactive halves fused to each partner protein (Gandía et al., 2008).
Partner oligomerization enables reporter protein complementation. A good example is
the yeast two hybrid system (Y2H), where the PPI drives the reconstitution of a func-
tional transcription factor, thus promoting the expression of a reporter gene. Other PCAs
rely on the complementation of fluorescent (Bimolecular Fluorescence Complementa-
tion, BiFC) or bioluminescence (Bimolecular Luminescence Complementation, BiLC)
(Ciruela et al., 2010). Alternatively, fluorescent resonance energy transfer (FRET) ap-
proaches have been commonly used to assess PPIs. These approaches also use genetically
modified GPCRs (i.e., tagged with fluorescent proteins) overexpressed in heterologous
expressing systems. In general, these technologies do not definitely prove the existence
of direct PPIs under native conditions; therefore, several techniques based on antibody-
based fluorescent probes have emerged to overcome this limitation. The proximity liga-
tion in situ assay (P-LISA) uses primary antibodies to detect receptors, which are then
recognized by secondary antibodies conjugated to a single-stranded oligonucleotide (re-
ferred to as the PLA probe). Then, if the two receptors are in close proximity (closer
than 40 nm), the PLA probes will hybridize with two connector oligonucleotides and a
ligase will generate a closed-circle DNA template that can be amplified through a rolling-
circle amplification step. Finally, by using complementary fluorescent-labeled oligonu-
cleotides, it is possible to detect the receptor-receptor interaction (Söderberg et al., 2006).
Interestingly, P-LISA has been successfully used to demonstrate the existence of several
GPCR oligomers in native tissue (Fernández-Dueñas et al., 2015; López-Cano et al.,
2019; Romero-Fernandez et al., 2022; Taura et al., 2015; Trifilieff et al., 2011).
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Below, we describe in detail the whole process of performing P-LISA in the brain, a tissue
that expresses many GPCRs that regulate important aspects of brain function (Huang
et al., 2017). Therefore, a step-by-step protocol is provided to perform P-LISA in brain
slices (Basic Protocol). Additionally, a support protocol will guide the reader through
slide observation, image acquisition, and quantification (Support Protocol).

NOTE: All protocols using live animals must first be reviewed and approved by an Insti-
tutional Animal Care and Use Committee (IACUC) and must follow officially approved
procedures for the care and use of laboratory animals.

BASIC
PROTOCOL

VISUALIZATION OF GPCR OLIGOMERS BY PROXIMITY LIGATION IN
SITU ASSAY (P-LISA)

P-LISA is a technology that overcomes the capacity of classical immunohistochemical
assays to allow the direct visualization of endogenous PPIs in situ (Söderberg et al.,
2006). The P-LISA, as a proximity ligation assay approach (Fredriksson et al., 2002),
depends on dual proximal binding by pairs of detection reagents, for example, two pri-
mary antibodies that recognize target antigens (e.g., GPCR) under study (Fig. 1A). Pri-
mary antibodies, which are raised in different species, are readily detected by specific
secondary antibodies containing a single complementary short DNA strand, also called a
PLA probe (Fig. 1B). When PLA probes from two secondary antibodies are close to each
other (≤40 nm), they can interact, and aided by two subsequently added linear connector
oligonucleotides, they generate an amplifiable circular DNA strand (Fig. 1C) that serves
as template for a local rolling-circle amplification (RCA) reaction (Fig. 1C). The RCA
reaction generates a single-stranded product covalently linked to the antibody-antigen
complex, which can be easily detected by complementary hybridization of fluorescent-
labeled oligonucleotides (Fig. 1C). Overall, protein targets can be readily detected and
localized with single-molecule resolution by means of fluorescence microscopy, thus al-
lowing unbiased quantification of PPIs in unmodified cells and tissues. Hence, although
other technologies can be implemented to unequivocally demonstrate the occurrence of
GPCR oligomerization in native tissue (i.e., TR-FRET using fluorescent ligands), the

Figure 1 Schematic representation of the proximity ligation in situ assay (P-LISA). (A) Specific primary anti-
bodies against GPCRs are used to detect each receptor, and secondary specie-specific antibodies conjugated
with oligonucleotides (PLA probe MINUS and PLA probe PLUS, illustrated as blue and orange bands, respec-
tively) recognize the primary antibody. (B) Two oligonucleotides (illustrated as green and clear-green bands)
hybridize with the PLA probes. When the PLA probes are in close proximity (≤40 nm) a circular ssDNA might be
formed (dark green rectangle). The open circular ssDNA could be closed by the action of T4 DNA-Ligase (illus-
trated as a pink oval). (C) Closed circular ssDNA can serve as a template for phi29 DNA polymerase (illustrated
as a sky-blue oval) that extends the 3’-OH ends of one of the PLA probes, acting as a primer for rolling circle
amplification (RCA). Finally, the generated concatemeric product is hybridized with fluorescent oligonucleotide
probes (red spots).
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P-LISA assay is a powerful and straightforward technology to uncover these types of
subcellular events, either transient or weak interactions, within specific subpopulations
of cells in situ.

Materials

CD1 mouse (in-house colony)
Ketamine (50 mg/ml; Ketalar, Panpharma)
Xylazine (20 mg/ml; Rompun, Bayer)
70% ethanol
4% formaldehyde solution (Sigma-Aldrich, cat. no. 1040021000)
1× PBS (see recipe)
Sodium azide (Sigma-Aldrich, cat. no. 769320-100G)
Walter’s antifreezing solution (see recipe)
Triton X-100 (Sigma-Aldrich, cat. no. X100-1 L)
Blocking solution (see recipe)
Normal donkey serum (NDS; Jackson ImmunoResearch Laboratories, cat. no.

017-000-121)
Duolink In Situ PLA Probe Anti-Goat PLUS (Sigma-Aldrich, cat. no.

DUO92003-30RXN)
Duolink In Situ PLA Probe Anti-Rabbit MINUS (Sigma-Aldrich, cat. no.

DUO92005-30RXN)
P-LISA wash buffer A (see recipe)
5× ligation solution (see recipe)
T4 DNA ligase (1 U/μl; Promega, cat. no. M1801)
5× rolling-circle amplification (RCA) solution (see recipe)
phi29 DNA polymerase (Life Technologies, cat. no. EP0091)
P-LISA wash buffer B (see recipe)
Duolink in situ mounting medium containing 4’,6-diamidino-2-phenylindole

(DAPI; Sigma-Aldrich, cat. no. DUO82040-5ML)
Transparent nail polish

27-gauge needle
1-cc syringe
Rack (for dissection)
Tape or pins
Surgical scissors
Forceps
Perfusion valve
25-gauge, 25-mm perfusion needle
50-ml syringe reservoir
Vibratome (VT1200, Leica Lasertechnik GmbH)
Round brush, sizes 10/0 to 2/10
Incubator, 37°C
Opaque Eppendorf tubes or foil-covered tubes
Microscope slides and coverslips

Fixed tissue preparation

The recommended dose for anesthetizing the animal (i.e., mouse) with the combination
of ketamine and xylazine is: 100 mg/kg body weight for ketamine and 10 mg/kg body
weight for xylazine (Flecknell, 1993). This guideline provides an onset of 3-5 min with
30-40 min of anesthesia duration for surgical purposes.

Of note, in our protocol, animals are housed and tested in compliance with the guide-
lines described in the Guide for the Care and Use of Laboratory Animals (Clark et al.,Taura et al.
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Figure 2 Schematic representation of tissue fixation and brain slice generation. The steps show the standard
procedure for obtaining brain slices from a whole fixed animal.The anesthetized animal is perfused intracardially
with a solution containing 4% formaldehyde. The brain is then extracted and post-fixed overnight. Finally, brain
slices are obtained using a vibratome and kept at −20°C.

1997) and following the European Community, law 86/609/CCE, FELASA and ARRIVE
guidelines. The protocol is approved by our Committee on Animal Use and Care. Thus,
the animals are housed in standard cages with ad libitum access to food and water and
maintained under controlled standard conditions (12 hr dark/light cycle starting at 7:30
a.m., 22°C temperature and 66% humidity). Regarding anesthesia, we recommend a bar-
biturate type (i.e., ketamine/xylazine combination), since gaseous types (i.e., fluothane)
tend to constrict vessels, resulting in poor fixative perfusion.

1. Add 2 ml 50 mg/ml ketamine (100 mg) and 0.5 ml 20 mg/ml xylazine (10 mg) to
7.5 ml sterile water to generate 10 ml ketamine/xylazine anesthetic solution. Mix
very well by gentle inversion.

This solution can be stored at 4°C for a maximum of 2 weeks.

2. Weigh the animal and inject intraperitoneally 0.1 ml of the ketamine/xylazine anes-
thetic solution per 10 g body weight (100 mg/kg ketamine, 10 mg/kg xylazine) using
a 27-gauge needle and 1-cc syringe (Fig. 2). Wait 3-5 min until the animal is deeply
anesthetized.

To increase the duration of the anesthetic effect, the dose of xylazine can be increased
(i.e., 15 mg/kg).

3. Once the animal is unconscious, check that the withdrawal reflexes (toe pinch) are
absent. Lay the animal dorsally on a rack above a container and secure each paw to
the rack with tape or a pin (Fig. 2).

Taura et al.
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4. Clean the ventral chest area with 70% ethanol and make an inverted T-cut through
the skin and the abdominal wall caudal to the last rib. Open the thoracic cavity by
cutting with scissors through the base of the sternum, perpendicular to the first cut.

Be careful not to damage the heart or lungs (Fig. 2).

5. Expose the heart by holding the rips out using forceps. Tear the pericardium with
the help of blunt forceps (Fig. 2).

6. Switch on the perfusion valve to start the flow. Insert the perfusion needle (25-gauge,
25-mm or wider if the flow rate is not fast enough) into the left ventricle and make
an incision in the right atrium to quickly drain fluids (a great deal of blood will be
released; Fig. 2).

7. Perfuse with 100 ml cold 1× PBS.

The reservoir (i.e., 50-ml syringe) containing the PBS solution should be maintained (and
continuously refilled) at 100 cm above the animal to ensure sufficient perfusion pressure
through the circulatory system. The blood from the circulatory system will exit through
the incision performed in the right atrium.

Increase the flow using larger gauge needles or increasing the height of the reservoir.
This will provide better results. Typically, it will take 1-10 min to wash the circulatory
system with the PBS solution, following which the eyes and liver will become clear. For
rat, use 200 ml 1× PBS solution.

8. Perfuse with ∼100 ml of ice-cold 4% formaldehyde in 1× PBS.

Tremors should be observed within seconds and at the end of the fixation process and the
animal should be stiff.

Due to the toxic nature of formaldehyde, all perfusion procedures should be performed
under the fume hood, and gloves and a lab coat should be used. The formaldehyde should
be collected and stored for disposal according to the regulations of your institution. For
rat, use 200 ml of fixative solution. The organs and the whole animal should be rigid
(including the tail) to the touch once the fixative solution has passed through the body.

9. Dissect and post-fix the brain by incubation (24 hr) in the same fixative solution
(4% formaldehyde) at 4°C. Swirl occasionally. Wash the brain with 1× PBS by
exchanging the medium three times, swirling each time.

The brain can then be stored in 1× PBS containing 0.1% (w/v) sodium azide at 4°C.

10. Obtain brain coronal sections (50-70 μm) using a vibratome (Fig. 2).

11. Keep the slices in Walter’s antifreezing solution at −20°C until use.

Slices should be manipulated with a round brush (size 10/0) to avoid tissue damage
(Fig. 2).

Free-floating P-LISA protocol
12. Rinse the slices three times for 10 minutes each with 1 ml 1× PBS to remove Walter’s

antifreezing solution (Fig. 3, step 1).

Use the round brush to manipulate the slices during the washing steps.

13. Wash slices with 1 ml 1× PBS containing 0.3% Triton X-100 for 2 hr at room tem-
perature (Fig. 3, step 2).

14. Wash the slices three times for 10 min each with 1 ml of 1× PBS containing 0.05%
Triton X-100 (Fig. 3, step 2).

15. Incubate slices with 250 μl blocking solution for 2 hr at room temperature (Fig. 3,
step 3).Taura et al.
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Figure 3 Flow chart showing all the incubation steps of the P-LISA. Several free-floating steps are performed:
permeabilization, blocking, primary antibody incubation, PLA probe recognition, ligation, RCA (including detec-
tion) and mounting.

16. Incubate the slices with 100 μl blocking solution containing the primary antibodies
overnight at 4°C (Fig. 3, step 3).

Primary antibodies against the antigens under study (i.e., A2AR and D2R) should be
raised in different animal species to avoid cross-reactivity of the PLA probes. For ex-
ample, in the example provided here, goat anti-A2AR and rabbit anti-D2R polyclonal an-
tibodies (Frontier Institute Co. Ltd., Shinko-nishi, Ishikari, Hokkaido, Japan) are used,
as previously described (Fernández-Dueñas et al., 2015). In addition, primary antibody
specificity should previously be demonstrated by conventional immunofluorescence stain-
ing under the same experimental conditions described here. In addition, each antibody
pair used should be specifically titrated for the P-LISA experiment.

17. Dilute 1:5 the two PLA probes provided by the manufacturer in a blocking solution
and allow the mixture to stabilize for 20 min at room temperature.

PLA probes are species-specific secondary antibodies that contain a unique short DNA
strand attached to them. Hence, PLA probes are verified both for specificity (e.g., for a
goat primary antibody use a PLA-probe anti-goat) and for complementarities (e.g., one
PLUS and another MINUS).

18. Wash slices for 10 min with 1 ml of 1× PBS containing 0.05% Triton X-100 and
1% NDS at room temperature (Fig. 3, step 4).

19. Incubate slices with 100 μl blocking solution containing the PLA probes for 1 hr at
37°C (Fig. 3, step 4).

Vortex the PLA probe mixture before adding to the slices. Note that steps 6 to 8 of Fig. 3
are performed in a similar manufacturer protocol manner.

20. Wash slices twice for 5 min each with 1 ml P-LISA wash buffer A at room temper-
ature (Fig. 3, step 5). Taura et al.
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21. Prepare 1× ligation solution by diluting 1:5 the 5× ligation stock solution (see
recipe) with high grade pure water.

22. Incubate slices with 100 μl of 1× ligation solution containing 0.025 U/μl of T4
DNA ligase (prepared by diluting 1:40 the 1 U/μl T4 DNA ligase into the 1× ligation
solution) for 30 min at 37°C (Fig. 3, step 5).

The T4 DNA ligase should be maintained at −20°C until diluted; use a freezing block
(−20°C) to transport. The ligation solution containing the diluted T4 DNA ligase should
be used immediately upon preparation.

23. Wash slices twice for 2 min each with 1 ml P-LISA wash buffer A at room temper-
ature (Fig. 3, step 6).

24. Prepare the RCA solution (1×) by diluting 1:5 the 5× RCA solution (see recipe)
with high grade pure water.

The RCA solution (1×) contains 1 mM dNTPs, 5% glycerol, 0.25 μg/μl BSA and 0.05%
Tween 20 according to previously reported information (Jarvius et al., 2007). In addition,
this solution contains the fluorescently labeled red probe that hybridizes with the single-
stranded RCA product and that can be visualized using a red-based laser system (see
below).

25. Dilute 1:40 phi29 DNA polymerase (10 U/μl) into the RCA solution (1×). Incubate
slices with 100 μl RCA solution containing 0.25 U/μl of phi29 DNA polymerase
for 2 hr at 37 ° C (Fig. 3, step 6).

This step must be performed using opaque Eppendorf tubes (or tubes covered with alu-
minum foil), since the RCA solution is light sensitive. The phi29 DNA polymerase should
be maintained at −20°C until diluted; use a freezing block (−20°C) for transport. The
RCA solution containing the diluted phi29 DNA polymerase should be used immediately
upon preparation.

26. Wash slices twice for 10 min each with 1 ml P-LISA wash buffer B at room temper-
ature (Fig. 3, Step 7).

27. Wash slices for 1 min with 1 ml of 0.01× P-LISA wash buffer B at room temperature
(Fig. 3, Step 7).

This wash step aims to remove salts from the slice prior to mounting for observation.
Thus, we recommend keeping slices in wash buffer B for 5-10 min until ready for mounting
(slices may collapse and deform if they stand for a long time in 0.01× wash buffer B).

28. Place and extend the slices on a microscope slide containing a drop of 0.01× P-LISA
wash buffer B (Fig. 3, step 8).

29. Add 10 μl of Duolink in situ mounting medium (or an equivalent) containing DAPI
to each slice. Place a coverslip on top of the slice and avoid the formation of air
bubbles. Seal the cover slip with transparent nail polish (Fig. 3, step 8).

The slides are kept in the dark for at least 1 hr before analysis in a confocal microscope.
The slides can be stored at 4°C for a maximum of 2 weeks, and for longer periods at
−200C.

SUPPORT
PROTOCOL

SLIDE OBSERVATION, IMAGE ACQUISITION, AND QUANTIFICATION

Slide observation, image acquisition, and quantification constitute a key step for the in-
terpretation of the P-LISA results. Indeed, obtaining good P-LISA images depends on
various optical factors that are far beyond the scope of the present protocol and have been
discussed elsewhere (Smith, 2011). Consequently, the use of a laser scanning confocal
microscope (LSCM) system allowing a specimen’s depth discrimination and contrast is

Taura et al.
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highly recommended. Therefore, the P-LISA-stained brain slice mounted on a confo-
cal fluorescence microscope slide is observed as a static image in the LSCM using the
appropriate excitation/emission wavelengths. Once the whole brain slice is observed, a
region of interest (ROI) is selected and the thickness within the z-plane is determined.
Next, serial optical thin sections are collected through the fluorescent ROI in steps of 0.2-
0.5 μm perpendicular to the z-axis (microscope optical axis) using proper illumination of
the laser system. The image series are collected by coordinating incremental changes in
the microscope fine focus mechanism—by using a stepper motor—with sequential image
acquisition at each step. Therefore, the information from each collected image is limited
to a definite specimen plane. Since confocal microscopy allows for a reduction in back-
ground fluorescence and improves the signal-to-noise ratio, the contrast and definition
of the collected images are dramatically improved over wide-field microscopy (Smith,
2011). On the other hand, confocal optical sectioning eliminates artifacts that occur dur-
ing physical manipulation (i.e., sectioning and P-LISA) of tissue specimens. Finally, the
confocal optical sections in the x-y plane and collected on the z-axis are combined along
the z-axis with the confocal microscopy software package, projecting a view of fluo-
rescence intensity. Alternatively, image stacks can be composed and analyzed using an
open-source Java-based image processing program allowing Java plugins and recordable
macros (i.e., ImageJ or Fiji; Schneider et al., 2012).

Materials

Laser scanning confocal microscope (LSCM; TCS 4D, Leica, or equivalent)
ImageJ (see Internet Resources)
Example of DAPI-stained nuclei and PLA probe stacks of images
Program that automates a series of ImageJ commands (recorded macro)

Slide observation
1. Visualize the region of interest (ROI) of each slice (i.e., striatum) using LSCM (i.e.,

Leica TCS 4D) with the aid of a 60× N.A. = 1.42 oil objective.

The use of an LSCM is essential to allow the precise location of the RCPs within a slice of
50-70 μm thickness. The DAPI stained nuclei within the ROI are visualized by exciting the
slide at 364 nm using an UV laser and the fluorescence emission is collected at 460 nm.
Similarly, the PLA probe detection is visualized throughout the oligonucleotide probes
typically labeled with a red fluorophore (λex=594 nm and λem=624 nm) using a 561-nm
laser system.

Image acquisition
2. Acquire independently the DAPI and PLA probe high-resolution images from a

5-μm thick optical section of each ROI. Establish a z-interval of 0.2 μm, to obtain
a z-stack of 25 sections.

The images should ideally be saved as an 8-bit RGB .tiff-format image and the dimensions
can be either 1024 × 1024 or 512 × 512.

Quantification

Image processing
3. Open ImageJ and load the stacks "DAPI.tif" and "PLA.tif."

This can be achieved by selecting [File > Open…], or simply by dragging and dropping
the files into the ImageJ menu bar.

4. Create a maximum intensity projection image for both stacks by selecting [Image >

Stack > Z project… > Max intensity].

This will generate a new image that displays the maximum pixel intensity across all the
slices in the stack. (Fig. 4).

Taura et al.
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Figure 4 Schematic representation of the confocal image stacks (n = 25) acquired for each
fluorescence channel (i.e., ch_1 and ch_2). Stacks are projected through the Z axis to generate
the Z-projected image of each staining. Scale bar: 10 μm.

Z-projection - Backgroud

ALPIPAD ALPIPAD

Z-projection - Backgroud
A B

-Background Grey

ALPIPAD ALPIPAD

-Background Grey

Figure 5 Scheme of the specific sequence of ImageJ commands necessary to perform a Z pro-
jection from a stack (n = 25) of DAPI (A) and PLA (B). The background is subtracted using the
rolling ball radius approach of 50.0 pixels (– Background; upper panels). Next, the image is trans-
formed into a gray image (Grey; lower panels). Scale bar: 10 μm.

5. Perform a background subtraction on both z-projection images using the built-in
function in ImageJ by selecting [Process > Subtract background…].

Although the nuclei and PLA spots differ in size, we found that the default rolling ball
radius of 50.0 pixels produced good results for both sample images (Fig. 5). To ensure
accurate background subtraction, set the radius to at least the size of the largest object in
the image that is not part of the background (i.e., nuclei). To determine the radius of the
largest objects in your image, you can use the line tool to draw a line from one edge of
the object to the other, and the length will be reported in the ImageJ toolbar. The default
rolling ball radius value in ImageJ is 50.0 pixels, which may be suitable for some images,
but might need to be adjusted for others depending on the size of the objects in question.

Taura et al.
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A B

DAPI DAPI

B & CGrey

E
PLA PLA

B & CGrey

PLA

B & C

PLA

BinaryB & C

DAPI DAPI

Binary

Figure 6 Digital transformations scheme for image analysis in ImageJ. Example images of trans-
formations of each channel transformations of DAPI-stained nuclei (A) and PLA dots (B). Bright-
ness and contrast adjustments (B & C; upper panels) of the grayscale images from Figure 5 are
subtracted. Next, a binary image transformation is performed (lower panels). Scale bar: 10 μm.

6. Enhance the visual contrast of the images by displaying both z-projections in
grayscale (as shown in Fig. 5), by selecting [Image > Lookup Tables > Grays] and
selecting the grayscale option.

This will help bring out the details and make it easier to distinguish between different
structures in the image.

7. Adjust the brightness and contrast by selecting [Image > Adjust > Bright-
ness/Contrast…] and adjust the settings until you reach the desired level of contrast.

This step can help enhance the image if you find that the spots in your z-projections are too
weak or difficult to see. However, be careful not to change the threshold values from one
image to the next, as this can affect the comparability of your results. Figure 6 provides
an example of how adjusting brightness and contrast can improve the visibility of spots.

When adjusting the brightness and contrast of your z-projections, aim to make the back-
ground as dark as possible and the signal as uniform and bright as possible. Keep a record
of the settings used so that you can apply the same parameters to the rest of the images in
your experimental set. Note that the settings you use may differ between channels, but they
must remain consistent for the corresponding channels across all the images analyzed. It
is important to remember that changing the background and contrast of the images will
alter the original intensity values. Although this may not be critical for particle analysis,
it could potentially impact other parameters and subsequent image analysis. Therefore,
it is important to exercise caution and ensure that any adjustments made are necessary
and well-documented.

8. Apply a smoothing filter to improve the image quality by selecting [Process >

Smooth] and select the desired smoothing filter.

If your resulting images exhibit excess noise or have particles with holes or gaps, this
can help reduce noise and improve the appearance of particles in the image, making
them easier to analyze.

If individual particles show gaps that could affect counting (particle analysis; nuclei
analysis and PLA signal analysis, steps 11 and 13, respectively), then use the smooth
filter to blur the active image or selection. This filter replaces each pixel with the average
of its 3 × 3 surroundings.

9. Segment z-projections and convert them into binary images (black-and-white repre-
sentations of the original image; as shown in Fig. 6) by selecting [Process > Binary
> Make Binary] and select the desired thresholding method. Taura et al.

11 of 20

Current Protocols

 26911299, 2023, 6, D
ow

nloaded from
 https://currentprotocols.onlinelibrary.w

iley.com
/doi/10.1002/cpz1.794 by R

eadcube (L
abtiva Inc.), W

iley O
nline L

ibrary on [02/05/2025]. See the T
erm

s and C
onditions (https://onlinelibrary.w

iley.com
/term

s-and-conditions) on W
iley O

nline L
ibrary for rules of use; O

A
 articles are governed by the applicable C

reative C
om

m
ons L

icense



Figure 7 Particle signal analysis scheme in ImageJ. Example of DAPI-stained nuclei and PLA
probe images with specific instructions for: (A) optional watershed filter application; (B) particle
analysis and counting of the total number of nuclei; (C) composite transformation of both channels.
Red arrows in (A) indicate examples of object segmentation and separation achieved by applying
the watershed filter. Scale bar: 10 μm.

This will help separate the foreground (signal) from the background, making it easier to
identify and analyze individual particles and facilitate the analysis.

ImageJ provides various global thresholding methods that can be accessed through [Im-
age > Adjust > AutoThreshold]. This feature allows you to test different methods and
select the one that best fits your specific images. For the provided sample images, the
default automatic thresholding method is sufficient. This method works by taking a test
threshold and calculating the averages of the pixels below and above it. Then it com-
putes the average of these two values, increments the threshold, and repeats the process
iteratively until the threshold is greater than the composite average. This approach can
effectively distinguish between the foreground (signal) and the background, producing
binary images that are suitable for further analysis.

Nuclei analysis

In this section, the cells of interest are counted using the binary mask that results from
nuclei segmentation.

10. Perform a watershed transformation (Fig. 7A) to separate objects that appear con-
tiguous in the binary mask by selecting [Process > Binary > Watershed].

This step is useful when the nuclei overlap or are very close to each other and are there-
fore difficult to resolve spatially.

11. Count nuclei >30 μm2 in the resulting binary image by selecting [Analyze > An-
alyze particles …] (Fig. 7B) and setting the following parameters: Size (μm2), 30-
Infinity; Show, Outlines; and Display results.

It is well established that within the brain (i.e., striatum), neurons and glial cells can be
discriminated by the size of their respective nucleus (Matamales et al., 2009). Therefore,

Taura et al.
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if the interaction upon study is expected to take place in neurons, as the example provided
here, the glial nuclei (<30 μm2) can be excluded from the quantification.

PLA signal analysis

In this section, the number of PLA probe particles is counted on its corresponding binary
mask. Then, a composite image containing both nuclei PLA spots is created, and the ratio
between the PLA probe particles and the number of nuclei calculated.

12. Apply a watershed transformation by selecting [Process > Binary > Watershed].

This step can be performed if the PLA signal overlaps, and thus the spots are difficult to
resolve spatially (Fig. 7A).

13. Count PLA probe particles >0.3 μm2 in the resulting PLA watershed image by
selecting [Analyze > Analyze particles..] and setting the following parameters: Size
(μm2), 0.3–10; Show, Outlines; and Display results.

Studies have reported that PLA probe particles may exceed the size of 0.3 μm2 particles
(Taura et al., 2015).

14. For visualization purposes, create a composite image that combines the projected
DAPI and PLA channels by selecting [Image > Color > Merge channels…] and
follow these steps:

a. Select the MAX_PLA image as C1 (red)
b. Select the MAX_DAPI image as C3 (blue).
c. Select the Create composite option to generate the merged image (Fig. 7C).

This approach can be useful for presenting your results in a clear and concise manner.

15. Obtain a quantitative measure of the PLA signal by calculating the ratio between the
number of PLA probe particles and the number of nuclei present in the sample.

Divide the number of PLA probe particles by the number of nuclei in the same image to
obtain the desired ratio.

16. Graph data that contain appropriate negative controls (Fig. 8).

Figure 8 Representative P-LISA result. Illustrative images of dual recognition of D2R and A2AR
P-LISA in the striatum and cortex of a wild-type animal (StriatumWT and CortexWT, respectively)
and the striatum of a A2AR knockout animal (StriatumKO). The PLA signal in the striatum was
significantly (***p < 0.001) higher than in the cortex or striatum of A2AR-KO mice. The values
correspond to the mean ± s.e.m. (dots/nuclei) of at least 6 animals for condition. Adapted from
(Fernández-Dueñas et al., 2015). Scale bar: 10 μm.

Taura et al.
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To establish several negative controls, it is essential to perform the same procedure under
different conditions. Specifically, the procedure should be performed in the absence of
primary antibodies as a negative control. Additionally, brain slices of the knockout animal
should be used to verify the specificity of the staining for at least one of the targeted
receptors. Lastly, defined negative brain regions that are expected to be devoid of targeted
receptors should be used as negative controls as well.

17. Perform a suitable statistical analysis of the results (Fig. 8).

REAGENTS AND SOLUTIONS

Use distilled deionized water in all recipes and protocol steps.

Blocking solution

Mix 10% normal donkey serum (NDS; Jackson ImmunoResearch Laboratories, cat.
no. 017-000-121) and 0.05% Triton X-100 (Sigma-Aldrich) in 1× PBS (see recipe)

Formaldehyde solution, 4% in 1× PBS

Mix 107.4 ml of 36.5%-38% formaldehyde solution (Sigma-Aldrich) with 100 ml
10× PBS (see recipe) and bring up to 1 L with H2O

Prepare fresh

Ligation solution, 5×
1.25 M NaCl (73.05 mg/ml)
5 mM ATP (2.75 mg/ml)
0.125% BSA (1.25 mg/ml; Sigma-Aldrich)
0.25% Tween-20
Store at −20°C up to 1 year

Phosphate buffered saline (PBS), 10×
80.7 mM Na2HPO4 (28.9 g/L)
14.7 mM KH2PO4 (2 g/L)
1.4 mM NaCl (80 g/L)
27 mM KCl (2 g/L)
Adjust pH to 7.2 using HCl or NaOH
Store at room temperature up to 6 months

Phosphate buffered saline (PBS), 1×
Dilute 1:10 the 10× PBS (see recipe) in H2O
Store at 4°C up to 1 month

P-LISA wash buffer A

150 mM NaCl (8.8 g/L)
10 mM Tris base (1.2 g/L)
0.05% Tween-20 (0.5 ml/L)
Adjust pH to 7.4 using HCl
Filter solution through a 0.22-μm filter
Store at 4°C up to 1 month

P-LISA wash buffer B

100 mM NaCl (5.84 g/L)
200 mM Tris (4.24 g/L Tris base and 26 g/L Tris·HCl)
0.05% Tween-20 (0.5 ml/L)
Adjust pH to 7.5 using either HCl or NaOH

Taura et al.
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Filter solution through a 0.22-μm filter
Store at 4°C up to 1 month

Rolling-circle amplification (RCA) solution, 5×
250 mM Tris·HCl (39.4 g/L)
50 mM MgCl2 (4.76 g/L)
50 mM (NH4)2SO4 (6.6 g/L)
Adjust pH to 7.5 using NaOH
5 mM dNTPs (1 mM of each)
25% glycerol
0.125% BSA (1.25 mg/ml; Sigma-Aldrich)
0.25% Tween-20
Store at −20°C up to 1 year

Walter’s antifreezing solution

30% glycerol
30% ethylene glycol (Sigma-Aldrich)
in 1× PBS (see recipe), pH 7.2
Store at −20°C up to 1 year

COMMENTARY

Background Information
Detection of low-abundance and/or tran-

sient receptor-receptor interactions requires
both high selectivity and sensitivity. The for-
mer may be achieved by using antibodies and
the latter by means of enzymatic activities.
Hence, the use of antibodies is a suitable
and resourceful approach for the detection of
endogenously expressed receptors and their
interactions. On the other hand, the sensi-
tivity may be boosted by enzyme-coupled
activity, prompting potent signal amplifica-
tion. Accordingly, the PLA combines the dual
recognition of an antibody-targeted assay with
a split-reporter enzymatic approach, thus gen-
erating a selective and sensitive method for
the specific detection of receptor-receptor
interactions (Fernández-Dueñas et al.,
2021).

The notion of using DNA ligation for an-
alytical purposes was initially proposed in the
early 1970’s after the discovery of ligases (Be-
smer et al., 1972). Subsequently, the use of
this concept ended with the description of
proximity-dependent DNA ligation assays, or
simply PLA, allowing the detection of zep-
tomole (40 × 10–21 mol) amounts of the cy-
tokine platelet-derived growth factor (PDGF)
without washes or separations (Fredriksson
et al., 2002). More recently, PLA or P-LISA
was developed to enable the detection of in-
dividual proteins and protein-protein interac-
tions in cultured cells and in native tissue
(Söderberg et al., 2006, 2008). Interestingly,
the P-LISA has both single-molecule resolu-

tion and superior dynamic range compared to
those of other current antibody-based proto-
cols, thus allowing relative signal quantifica-
tion and localization.

Critical Parameters

Tissue fixation
Tissue fixation is one of the most critical

steps for the success of P-LISA. Indeed, since
P-LISA depends on specific epitope-antibody
interactions, the preservation of tissue mor-
phology and antigenicity of target molecules
(i.e., GPCR) is extremely important, as hap-
pens for all immunohistochemical procedures
(Ramos-Vara & Miller, 2014). Accordingly,
incomplete fixation (underfixation) of tissue
(e.g., brain) may lead to rapid proteolytic
degradation of target proteins (i.e., GPCRs),
thus reducing specific immunoreactivity.
Importantly, within the brain there are areas
that easily fix (e.g., cortex) while others (e.g.,
striatum) are more resilient to perfuse with
the fixative solution and thus are prone to get
underfixed. An underfixed tissue (i.e., with
pink-colored appearance) will render a low
number of P-LISA puncta, thus underesti-
mating the amount of P-LISA signal (i.e.,
GPCR interaction) and minimally reducing
the differences from the background. Hence,
a poor fixation cannot be corrected at a later
stage and is a common source of problems
for the detection of P-LISA. On the other
hand, an excess of fixation (overfixation) may
end with epitope masking or with an intense Taura et al.
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nonspecific P-LISA background, which may
blur specific labeling. Generally speaking,
underfixation is a much greater problem than
overfixation and consequently, special atten-
tion should be paid to all key steps within the
tissue fixation process (i.e., fixative, duration,
temperature, and pH; Fig. 2), which will in
fact affect the degree of tissue fixation and
thus the P-LISA detection.

Whole animal perfusion fixation, as pre-
sented here, may not be sufficient to fix the
tissues of interest. In such cases, dissected tis-
sue (e.g., brain) can be immersed in fixative
solution overnight (i.e., post-fixation). To en-
hance the penetration of the fixative during
post-fixation, it is recommended that tissues
be no thicker than 10 mm. On the other hand,
the volume of the fixative should be 50-100
times larger than the volume of the tissue.
If the tissue floats, it should be submerged.
Again, it is important to optimize both fixation
and post-fixation conditions, since underfixa-
tion or overfixation may reduce or preclude the
P-LISA signal.

Finally, it is important to mention here that
while sample preparation in fixed tissue-based
PLA methods (i.e., P-LISA) is very laborious
and therefore time-consuming, the implemen-
tation of PLA techniques in isolated cultured
cells could be a suitable and easy alternative to
visualize GPCR interactions. Indeed, since the
fixation procedure for cultured cells is quite
straightforward, most users will not have dif-
ficulty obtaining appropriate results in adher-
ent or suspended cell lines (Leuchowius et al.,
2011).

Antibodies
The most important aspect when designing

a P-LISA experiment is primary antibody
pair selection. Indeed, the critical feature of
any primary antibody is specificity for the
epitope (i.e., GPCR), therefore all primary
antibodies used in P-LISA should be first
tested for specificity in immunohistochem-
istry experiments using proper controls (see
below). Subsequently, all P-LISA steps must
be optimized to visualize specific staining and
minimize nonspecific background signals.
This initial antibody characterization of the
incubation conditions includes: (i) working
dilution (i.e., primary antibody concentra-
tion), (ii) temperature, (iii) diluent solution,
and (iv) incubation time. All these conditions
should be empirically optimized by means
of immunohistochemistry experiments for
each primary antibody, either monoclonal or
polyclonal, and also for the specimen used.

The binding of the antibody to its recog-
nizing protein depends on the preservation of
the native conformational state of the target
protein. Importantly, access of the antibody
to its epitope could be conditioned by post-
translational modifications, protein-protein
interactions, diluent salt concentration, tem-
perature, pH, and fixation (see above). Since
polyclonal antibodies can recognize multiple
epitopes within the target protein, they are less
prone to being influenced by conformational
changes. On the contrary, because mono-
clonal antibodies bind with high affinity and
specificity to a single epitope, disruption of
the target protein conformation may preclude
recognition and thus antigen detection. Addi-
tionally, polyclonal antibodies are more stable
over a range of pH and salt concentrations
when compared to monoclonal antibodies.
Overall, polyclonal antibodies are used more
frequently in P-LISA experiments, but when
the detection of close related proteins (i.e.,
homologous receptors) is compromised then
the use of monoclonal antibodies is recom-
mended.

Optimization of P-LISA detection is ini-
tially assessed by maintaining the temperature
and incubation time constant, while varying
the concentration of the primary antibody to
determine the optimal P-LISA signal. There-
fore, a high affinity primary antibody may be
used at high concentrations for shorter incuba-
tion times or at lower concentrations but with a
longer time. However, longer incubation peri-
ods (i.e., overnight) at lower temperatures (i.e.,
4°C) are often preferred to promote specific
staining and guarantee antibody penetration
throughout the tissue section. To increase an-
tibody penetration, incubations could be per-
formed with free floating tissue sections.

Controls
As a general rule in research—and P-LISA

is not an exception—proper controls are
key elements to consider any experimental
approach as a trustworthy technique. Accord-
ingly, in addition to the above-mentioned
considerations, some key controls should be
considered when P-LISA experiments are
performed. First, the nonspecific binding of
PLA probes to the sample tissue should be
checked. Hence, the whole protocol should
be performed in the absence of the primary
antibodies. Because PLA probes are not
expected to recognize any sample epitope
apart from the primary antibodies used in the
P-LISA experiment, the resulting stain should
be low. Second, to confirm the specificity of

Taura et al.
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Table 1 Frequent P-LISA Problems: Possible Causes and Solutions

Problem Causes Solutions

Low Signal Underfixation Revise concentration, temperature, and pH of
the fixative solution; increase duration of the
fixation process

Inappropriate primary antibody Select an antigen-specific antibody and validate
its antigen detection properties by alternative
methods (e.g., Immunoblot, etc.)

Wrong concentration (i.e., too low) of the
primary or PLA probes

Optimize the concentration

The activity of primary antibody or PLA
probes is lost

Check the antibody storage condition and
perform an experiment using a positive control

Wrong pH of the primary antibody
solution

Ensure that the primary antibody works
properly

Deficient permeabilization Increase the concentration of the
permeabilizing agent (i.e., Triton X-100)

Low or no fluorescence signal The fluorescently-labeled probe should be
stored in the dark

High background
signal

The concentration of the primary
antibody was too high

Dilute the primary antibody

The incubation time of the primary
antibody was too long

Reduce the incubation time of primary
antibodies

The temperature of primary antibody
incubation was high

Perform the primary antibody incubation at 4°C
to allow an increased incubation time and thus
antibody penetration

Serum was absent or insufficient in the
blocking solution

Revision of serum concentration and/or
increase in blocking time

Inadequate buffer A/B washing Wash with buffer A/B for an adequate amount
of time and several times to eliminate fixatives

Polyclonal primary antibody Try a monoclonal primary antibody

Nonspecific
staining

Overfixation Reduce the duration of the fixation process;
revise concentration, temperature, and pH of
the fixative solution

Deficient washing after incubation with
primary antibodies and PLA probe

Wash with buffer A/B appropriately

The concentration of the primary
antibody or PLA probe was too high

Decrease the concentration of primary antibody
or PLA probe

The PLA probe is the same species as the
sample origin

Change the PLA probe

the primary antibodies in a P-LISA exper-
iment, tissue samples where either one or
both receptors are not expressed are required.
Therefore, tissues obtained from knockout
animals should be used in the detection of P-
LISA. Finally, another interesting control may
consist of performing the P-LISA detection
in a tissue or a region of the tissue where the
interaction is expected not to occur. Overall,
three types of controls are recommended in
P-LISA experiments: (i) PLA probe speci-

ficity, (ii) primary antibody specificity, and
(iii) sample/tissue selectivity.

Even though the output of the P-LISA tech-
nique is an image, proper computational pro-
cessing allows us to quantify data. This can
be achieved by using the ImageJ program
“Analyze particle” function located in the
Analyze menu toolbar. To be able to have reli-
able values of the PLA probes dots, it is impor-
tant to process all images using the same set-
tings for background subtraction and contrast Taura et al.
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enhancements. It is also crucial to determine
which size dots can be considered as back-
ground, since the function will only count par-
ticles that fit in a given size range.

Troubleshooting
The success of the P-LISA method depends

primarily on the quality of the antibodies used
and the sample preparation mode. The main
problem often found when using antibodies
is the lack of antigen recognition, cross-
reactivity (i.e., the antibody binds to other
proteins), and nonspecific absorption (i.e.,
the antibody is trapped within the sample
in an unspecific manner). These facts might
limit the specificity of the P-LISA method.
On the other hand, the use of an enzymatic
activity for signal amplification might also
prompt false P-LISA detection. In general,
the difficulties often found to cause a lack
of detection, nonspecific staining, or a high
background are shown in Table 1.

Understanding Results
We took advantage of P-LISA to detect

D2R-A2AR oligomers in the striatum of con-
trol and parkinsonian rats (Fernández-Dueñas
et al., 2015). In our hands, the P-LISA signal
observed for this GPCR oligomer in the rat or
mouse striatum was consistent and within the
same range (5-6 dots/nuclei) to that described
previously (Trifilieff et al., 2011). Interest-
ingly, our negative controls (i.e., A2AR-KO
and brain cortex) provided 0.5-1.5 dots/nuclei.
Therefore, the specific P-LISA signal for D2R-
A2AR complexes in the rat/mouse striatum
is typically about 3-10 times higher than
the background signal. In fact, the obtained
P-LISA results were validated using two alter-
native techniques (i.e., immunogold staining
and electron microscopy detection, and
RET experiments using fluorescent ligands;
Fernández-Dueñas et al., 2015). In general,
P-LISA is a powerful and straightforward
technique for visualizing receptor-receptor
interactions in native tissue provided it is
performed under optimal conditions and also
includes proper appropriate controls.

Time Considerations
Typically, the entire protocol can be per-

formed in o1 week. On the first day, the ani-
mal is anesthetized and fixed, and the brain is
post-fixed overnight. The second day, the brain
is sliced and stored at −20°C in Walter’s an-
tifreezing solution. The third day, the slices are
washed, blocked and incubated overnight with
primary antibody solution. On the fourth day,
the slices are incubated with the PLA probes,

then the ligation and the RCA is performed; fi-
nally the slices are mounted on a slide and left
overnight to make sure the samples are ready.
Finally, the last day, the acquisition and the im-
age processing can be performed.
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